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NOTE 

DOCUMENTATION CONVENTIONS 
 

This uses the following conventions to present information: 
 

  
 
 
 
 

 
 
 

 
 
 
 
 
  
 

An exclamation point icon indicates a WARNING of a situation 
or condition that could lead to personal injury or death. You 
should not proceed until you read and thoroughly understand the 
WARNING message. 

WARNING 

CAUTION 

A raised hand icon indicates CAUTION information that relates to 
a situation or condition that could lead to equipment malfunction 
or damage. You should not proceed until you read and thoroughly 
understand the CAUTION message. 

A note icon indicates NOTE information. Notes provide additional 
or supplementary information about an activity or concept. 
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Section 1: System Description 
 

Function and Theory 
The 3A-300 holds a maximum of 400M of Ø 0.10” steel armored logging monocable, and, 
with the exception of Borehole Video, is compatible with all Delta Epsilon probes and 
acquisition systems. 

System Components 
The 3A-300 incorporates a semi-automatic levelwinding system. When coming out of the 
hole, you may need to assist levelwinding on the outside edges of the drum to distribute 
cable evenly. Failure to spool the cable evenly may cause premature damage. This is 
especially important if your winch has more than 300 meters of cable installed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The 3A-300 winch is equipped with a manually operated disk brake that is coupled to the 
winch drum through a one-way clutch. This restricts braking action to downward forces 
and while offering no restriction when coming up hole. Thus, the brake may be set at the 
bottom of the hole, and left set during the trip out of the hole. This prevents the probe from 
creeping downhole when stopped and is especially useful when hand cranking the winch. 
You may let go of the crank at any time without fear of the probe going back downhole. 
 
All electrical connections to the 3A-300 winch are keyed and are such that making a 
wrong connection is virtually impossible. Logging requires connecting a maximum of four 
cables to the winch. One connection for D.C. electrical power, a USB cable to your PC, 
and, when acquiring electrical logs, two surface electrodes. Approximately 8 meters of the 
logging cable, on the cablehead end, is sheathed with Nylon tubing. This is to insulate it 
from the borehole when electrical logs are run. Any nicks or damage to the tubing should 
be covered with good quality electrical tape (such as Scotch 88). 
 
 

Measuring Wheel/Depth Encoder 

Levelwind Handle 

Emergency Hand Crank Port 

Cablehead Storage Tube 

Brake Handle shown in 
OFF position, rotate handle 

counter-clockwise to 
engage the brake. 

Figure 1-1 
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Depth Encoder connector 
 

Motor Circuit Breaker 
 

Power In connector 
 

Motor connector 
 
 

 
 
 
 
 
'B' Mud plug connectors (both must be used) 
 
 
USB connector 
 
Emergency hand crank handle 
 
'n' Mud plug connector (both must be used) 
 
 
 

Figure 1-2 

Figure 1-3 



 

5 
 

Section 2: System Installation 

3A-300 Motor Driven Winch 
The 3A-300 system requires a stable source of 12 to 14vdc at 10Amps maximum for the 
winch motor drive and electronic circuitry to measure depth, speed and communicate with 
your PC and the probe. Current draw during normal logging is between two and four 
amps. Power may be provided by a vehicle battery or similar D.C. power source. Be sure 
to connect the RED power lead to the positive (+) terminal and the BLACK lead to the 
negative (-) terminal. To avoid possible short circuits or shock to the operator, the 3A-300 
must be used with negative ground systems only. 

 
 
WARNING: The 3A-300 must be used with negative ground systems only! 
 
 

The UP-STOP-DOWN switch to controls cable direction while the SPEED control allows 
controlling cable speed from zero to maximum. 
 

NOTE: The direction switch is a mechanical hesitation type switch and will 
only allow toggling from one position to the next without a hesitation 
(releasing the toggle) before continuing to the next position. That is, the 
switch cannot be toggled directly from UP to DOWN without a pause at 
STOP. This prevents accidental damage to the motor and its drive 

components. It also allows the direction switch's position to safely be changed regardless 
of the position of the SPEED control. 
 

CAUTION: When spooling 
cable off of the drum (DOWN) 
be sure to maintain tension 
on the cable to prevent the 
cable from becoming loose 
on the drum. This could 

cause a loop of cable to cross over adjacent 
cable or to allow a large loop to fall off the 
side of the winch drum and become 
entangled in the chain or brake mechanism. 
 
The winch controller is designed to provide 
fail-safe operation. If primary power from the 
battery is not applied or primary power fails, 
the winch controller will apply maximum 
dynamic braking. Similarly, when the direction 
switch is on STOP, maximum dynamic 
braking is applied. Thus, in normal operation, 
power must be available in order to pull cable 
from the drum.  
 
If power is not available and cable must be 
spooled out, you may disable the dynamic 
braking by disconnecting the winch motor's 
cable. With the motor cable disconnected no 

 

Figure 2-1 
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dynamic braking can be applied. Motor speed may be controlled with the mechanical disk 
brake. 
 
Two LED's, "PC" and "Probe" flash briefly when communicating with the PC or Probe. 

Connecting the Winch to a PC 
Connect the 3A-300 to your laptop via the USB cable and turn the POWER switch ON 
(PROBE switch off). On the top line of the display you will see the 3A-300's model and 
serial numbers displayed for a few seconds, followed by the current depth and logging 
speed. On the bottom line is a message area, in this case showing "No Probe" is attached 
and the input power voltage is 12.6VDC. You can now launch DELogger and preset the 
depth. 
 

 
Refer to Appendix B for instructions on setting up DELogger's COM port to agree with the 
COM port Windows assigned to your USB port. 

Connecting a Probe  
When not in use always keep the probe top and cablehead protector caps in place to keep 
the connectors, O-rings, O-ring glands, and threads free from dirt.  
 
Set the PROBE/CONNECT switch to PROBE (off) position. Remove the protector caps 
from the probe and cablehead and apply a thin film of O-ring grease on the cablehead O-
rings and mating surfaces. Insert the cablehead into the probe top, aligning the key on the 
cablehead with the key in the probe top. Press the two together while screwing the 
cablehead retaining nut onto the probe. When fully assembled the bottom of the retaining 
nut should come to within about 1/8” (3mm) of the probe top. Do not use wrenches to 
tighten the cablehead retaining nut. Use only normal hand force.  
 
When a probe is properly connected, turn the PROBE/CONNECT switch to CONNECT. 
During the connection process you will see the following screens while the EPCI circuitry 
searches for a probe connected to the cable. After a short delay, if the EPCI does not 
sense a probe it will then cycle downhole power and try again until a probe is detected. 
 

 
Attempting connection to battery 
powered probe (such as 
GE9409/GN9506). 
 
 

 
 
 
Attempting connection to uphole 
powered probe. 
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When a probe is detected its model 
and serial numbers are displayed for 
a few seconds. 
 
 

 
 
 
 
It is followed by either the state of 
charge of the probes internal battery 
(such as with a GE9409 or GN9506 
probe) or the voltage of the winch's 
main input power. 
 
 
 
 

 
The example above shows the depth at 123.00 meters with a GN9506, battery powered, 
Gamma-Electric probe whose batteries are at 100%. Beneath it is a GT9502 Gamma 
probe showing 12.6 volts being supplied to the winch. 

Burying the Surface Electrodes 
Surface electrodes are required when using probes measuring electric properties (Short or 
Long normal Resistivity, Spontaneous Potential, Single Point Resistance, etc.). The Delta 
Epsilon system uses two surface electrodes (“mud plugs”) which are made of Type 304 
stainless steel in the shape of paddles for easy burying and cleaning. Best results are 
attained when the mud plugs are buried as far from each other as possible and as far from 
the hole as possible. The electrical connection to the mud plugs (where the wire connects 
to the mud plug) must be 
sealed and protected from 
moisture. During initial 
manufacture the handle 
portion of the mud plug is 
covered with heat shrink 
tubing with a meltable inner 
liner that forms a waterproof 
seal around the connection. 
If this becomes nicked or cut, 
use electrical tape as 
necessary to restore and 
maintain a waterproof seal. 
 
 
 
 
  Figure 2-2: Mud Plugs in Use 
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Section 3: System Operation 

Logging a Borehole 
Although each logging site is different, below is a typical sequence of events to set up and 
log a borehole. 

• Place the winch on a dry area at a convenient distance from the borehole. You 
should be at least 5 meters from the borehole. 

• Set up the tripod over the borehole. 
• Connect the winch to a suitable source of 12-14VDC power. 
• Turn the control box POWER switch and EPCI POWER switches to ON. 
• Set the direction switch to DOWN, turn the SPEED knob fully clockwise, make 

sure the brake is off (handle vertical) and pull out enough cable to reach the 
borehole plus a meter or two extra. 

• Set the brake and rotate the SPEED control fully counter clockwise. 
• Remove the probe top and cablehead protector caps. 
• Connect the cablehead to the probe. 
• If the probe includes electric logs, tape over any exposed metal on the cablehead 

and probe top and bury the surface electrodes (see Appendix A for details).  
• Turn the EPCI's PROBE switch to CONNECT and, after a few seconds, observe 

the connected probes model and serial number in the display. 
• Lower the probe into the borehole. Rotate the tripod as necessary to make sure 

the cable runs straight and true over the tripods sheave wheel. Rotate the cable 
wiper out of the way as it is not necessary on the trip into the borehole. 

• With the brake set, switch the direction switch to UP and turn the SPEED control 
clockwise to slowly bring the cablehead/probe top junction up so it is even with 
ground level. 

• In DELogger, preset your acquisition depth to zero. Probe sensor depth offsets 
are automatically taken care of during data acquisition. 

• Release the brake, switch to DOWN and rotate the SPEED control to lower the 
probe to the bottom of the hole. 

• When you reach the bottom of the hole: 
o Set the brake (lever approximately horizontal). 
o Enter the depth of the probe in the box labeled Acquisition Depth in 

DELogger. 
o Click the X next to the box to set the depth in DELogger. 
o Turn SPEED fully counter clockwise. 
o Switch to UP. 
o Rotate SPEED to slowly spool cable in and take any slack out of the 

cable. 
o Rotate the cable wiper on the tripod so it will wipe the cable as it comes 

out of the borehole. 
• Click on LOG in DELogger and notice the status line (lower left hand corner of 

the screen) change from "idle" (or "status") to "logging." 
• Turn SPEED to come up the borehole at the desired logging speed. If acquiring 

data at 10cm intervals, 5-7m/min is a good logging speed. Finer acquisition 
intervals may require slowing your logging speed down. If the logging speed is 
too fast you will get "Logging too fast" error message from DELogger (indicating 
a data interval may have been lost). 

• While logging up, keep an eye on the DEPTH. When it nears zero you will want 
to slow the winch and prepare to stop it when the cablehead/probe top are level 
with the ground (as it was when you started logging). 
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• Click on SBY in DELogger to stop acquiring data. 
• Edit the log's header and, when finished, click on File/Save (or the disk icon) to 

save your file. You may edit the log's header at any time. 
• When you are finished logging, turn the PROBE switch to OFF and you can 

safely disconnect the probe. 
• Install the protector caps on the probe and cablehead. 
• Wipe excess mud/water from the cable while spooling it into the winch. 
• Store the cablehead in the storage tube provided. 
• Turn all POWER switches OFF and store everything in its storage containers. 

Take Down 
When finished logging or when the system is not in use always keep the probe top and 
cablehead protector caps in place to keep the connectors, O-rings, O-ring glands, and 
threads free from dirt. Keep the O-rings and mating surfaces and the probe top and 
cablehead retaining nut threads free from dirt and grit. When clean, apply a thin film of O-
ring grease to each surface. Wipe the probe down before storing it in its protective case. 
Keep the winch covered and all probes and cables protected from the elements. 
 
Refer to Appendix A for special considerations when using Electric logging probes or 
battery powered probes (such as GE9409/GN9506). 

DELogger Log Acquisition Software 
 
Overview 
DELogger is a program used for simple data acquisition from Delta Epsilon logging 
hardware using a laptop or other personal computer. It requires a system operating with 
Windows 95, 98, XP, Windows NT, or Windows 7. DELogger can collect a set of logs from 
the logging system, write it to a disk file, print it to any Windows installed printer, and play 
back previously recorded logs. 

 
NOTE: Selecting Plot without a dedicated Delta Epsilon Plotter attached 
will cause the program to crash. DELogger must then be closed and 
restarted. 
 

Operation of DELogger is based on a chosen set of logs called a log configuration herein. 
First, you choose a log configuration. Then, DELogger tries to access the proper logging 
tool or load matching data from a file. Data must be available for every log that is in the 
chosen log configuration, but it is not necessary to include, in the chosen configuration, 
every log that is available from the logging tool or from the file. Any number of log 
configurations may be created and saved. A particular configuration is chosen by selection 
from a list and facilities are included to maintain the list. 
 
The properties of each log may be chosen while setting a configuration. You may choose 
which to display: a log, its color, whether it is filled, and whether it is filtered. 
Once a log configuration is chosen, that set of logs is displayed on the screen. You may 
choose and change the depth scale, the bias and span for each log, and the range of 
depths currently displayed. Keyboard shortcuts are included to make these adjustments 
possible by either use of the mouse or use of keystrokes. At any time, the scales currently 
displayed may be saved manually. These scale settings become the default settings for 
the currently chosen log configuration. 
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At any time, all of the data for the chosen log configuration is retained in your computer’s 
memory much like a document in a word processor. You may stop logging, and then 
continue logging or you may re-run parts of the hole to overwrite data already collected. 
The data currently in memory may be saved to a file that is written in a standard LAS v2.0 
format. The current data may be completely deleted at any time to clear the data set for a 
new log. A previously saved log may be re-loaded into memory form its LAS file. 
 
Data is collected from the hardware through your computer’s serial port. A commercially 
available RS-232 to USB converter may be used to connect to PC’s that have no RS-232 
(COM) port. Data acquisition is initiated by clicking the Log button. At this time, the 
program checks that communications with the logging tool are possible. Acquisition of 
logging may be suspended or stopped by clicking the SBY button. Acquisition may be 
resumed by again clicking the Log button. 
 
Header data is saved in the LAS file with the log data. Header data may be entered at any 
time: before, during, or after logging. The currently entered header data becomes the 
initial header data for the next log to minimize re-entry of header information. Header 
topics may be added or deleted. 

Quick Tour of DELogger 

 
Set up Log Display Parameters 

• From the menu, Choose Edit and Log Configuration. 
• Click the down-arrow in the Drop Down box and click Four Logs. 
• Click OK. Note the logs that will be displayed and their colors. 
• From the menu, choose Edit and Log Configuration again. 
• Click the box for NGAM and Color. Enter the number 5. 
• Click OK. Note that the color of the Gamma trace has changed. 

 
Set up Logging Parameters 

• From the menu, Choose Edit and Log Configuration. 
• Click the tab labeled Logging Parameters. 
• Click the small arrows to increase or decrease the data interval. 
• Alternately, enter your own data interval. 
• Click OK. 

 
Set up the Header Information 

• From the menu, Choose Edit and Header. 
• In the column labeled Entry, enter information of your own choice. 
• Add an entry in the header 
• Click the bottom line of the grid, next to the small star. 
• Enter information of your choice. The Description is the text that will be printed to 

identify your data. The LAS column is a pneumonic that will identify this data in 
the LAS file. See Saving Currently Displayed Data. 

• Delete an entry in the header 
• Click any box in the row to be deleted. 
• Click Delete. 
• Click Close. 

 
Connect and check the Logging Probe 

• Connect the logging probe to the winch and the USB cable to the computer. 
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• Click Hardware and Check Hardware. 
• If the hardware and the software are correct, a box will be displayed that shows 

the hardware model numbers and serial numbers. 
• If the hardware is not operational, or the wrong probe is connected, an 

appropriate message will be displayed. 
• Collect some data 
• Run the winch and align the top of the probe with the top of the hole (which is 

zero depth) or with some other known depth reference. The reference point on 
the probe is the top of the probe. 

• Double click the box labeled Acquisition Depth and enter the reference depth. 
• Click the X next to the box to set the reference depth into the computer and into 

the winch. 
• Run the winch to the bottom of the hole or to a point at which you want to begin 

logging. 
• Click LOG. 
• Run the winch at the chosen logging speed. Note the data being collected. At 

any time, scales may be adjusted. See the next step. 
 
Adjust the scales and the display 
Click the box at the top of the log. A box showing span and bias will appear. Adjust span 
and bias by clicking the arrow or by double clicking the text box and entering values. 
Experimentation allows you to set any span and bias to display the log as you wish.  

 
 
NOTE: The display settings do not affect the data that is recorded for the 
log. The recorded data is in absolute units. 
 

 
Save the currently displayed scales 
From the menu, click Edit and Save Scales. The currently displayed scales will be the 
scale settings the next time you start DELogger. 
 
Adjust the length of the log displayed. 
Click the down arrow in the box showing ft/in or m/cm. Select a scale. The scale of the log 
will be adjusted. 
 
View a different part of the log. 
Click or drag the scroll bar at the right side of the log to view data above or below that 
being displayed. While you are logging, DELogger will try to keep any recently collected 
data in view so the scroll bars may move back where they were. 
 
Save the currently displayed log in an LAS file 

• From the File menu, select Save As. 
• Select the folder to save the file. 
• Enter a file name and click Save. The “.LAS” extension is added automatically. 

 
View a log previously saved 

• From the menu, click Edit and Clear. 
• From the menu, click File and Load. 
• Enter a directory and a file name. 
• Click Open. 
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• The LAS file will be displayed. 
 
 
Print a log that is displayed 
From the menu, click File and Print. Choose your printer and set it up as usual. The log 
will be printed on your printer. 
 
Adjusting scales 

• Log scales are adjusted by clicking the scale box at the top of the corresponding 
log. A scale-adjustment box drops down and displays buttons and text boxes in 
which you may adjust both bias and span. The buttons adjust the scale values in 
a direction to move the log curve in the direction of the button. The boxes allow 
you to enter a specific scale if you so choose. To close a scale adjustment box 
click anywhere on the logs or press the escape key.  

• The scales may be operated from the keyboard as well as with using the mouse. 
The tab key cycles through each of the scale-adjustment boxes and then to the 
depth scroll bar. When a scale adjustment box is shown, the bias may be 
adjusted using the left and right arrow and the span may be adjusted using the 
up and down arrows.  

• The depth shown in the display is adjusted by clicking and/or dragging the scroll 
bar at the right of the screen. A click of the small arrows at the top of the bar 
adjusts the depth displayed upward or downward by one division. A click 
between the arrow and the scroll-bar button adjusts the depth displayed upward 
or downward by on full screen. Dragging the button from top to bottom scrolls the 
log from top to bottom. When the scroll bar has the focus, indicated by its 
flashing, then depth shown in the display may also be adjusted by using the up, 
down, page-up, and page-down arrow keys.  

• The range of displayed depths is adjusted by selecting the depth scale (ft./in.) on 
the toolbar. You may adjust the depth scale to some large value, say 50 ft/inch to 
display the entire log. Then you may adjust the depth scale to some normal 
value, say 10 ft/inch to display detail.  

 
Checking the Hardware 

• On the menu, select Hardware/Check Hardware.  
• If no communications to the EPCI can be established a message will be 

displayed. 
• If communications to the EPCI can be established but no probe is connected or 

the probe is not working properly, a message will be displayed. 
• If communications are established and a probe is connected, a box will be 

displayed showing model numbers, serial numbers, and software versions. 
 
Choosing a Log Configuration 
A log configuration is a particular choice of logs and a particular assignment of plotting 
parameters for each log. You may choose: 

• the API grid that each log will be plotted upon 
• the color displayed for each log  
• whether or not the area under the log curve is filled 
• whether or not the log is filtered 
• Each log is given a name. For example, NGAM is the natural gamma-ray log; 

SPR is the single point resistance. The names of all available are displayed when 
a ‘new’ display configuration is chosen. 
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NOTE: If you have a calibrated gamma probe, you can add an Assay trace 
which calculates %eU308 from the gamma curve. Choose ASSY from the 
pull down menu of log names. Scroll to the far right to enter your probes k 
factor. 
 

• To choose, create, or edit a display configuration, choose Log Configuration from 
the Edit menu or click the related toolbar button. 

• To change to another configuration, click the drop-down list box and click the 
chosen configuration from the list. 

• To delete an entire configuration, click the Delete button next to the drop-down 
list box. 

• To create a new configuration, click the new button next to the drop-down list 
box. Edit the text to describe this configuration. Then add logs as below. 

• To delete a log from a configuration, click the log ID in the grid and then click the 
Delete button below the grid. 

• To add a log click the add button below the grid. Then choose the log you want to 
add from the pop-up list box. Then choose the grid, color, initial span and bias 
values, and the Fill and Filtered options. You may change the descriptive title for 
a log.  

 
CAUTION: Choosing a new configuration erases any log data currently in 
memory. Therefore, you should not change the log configuration before 
current data have been saved and you should use care to assure that a 
new ‘blank’ file is not saved to the file name as an existing file. 
 

Clearing the screen 
All of the logs shown may be cleared by selecting Clear from the Edit menu or by clicking 
the corresponding tool. Clearing deletes all of the log data in memory. 
 
Copying to the clipboard 
A copy of the logs as they are displayed on your screen may be copied to the clipboard 
and pasted into another application such as a word processor. To copy to the clipboard, 
select Copy from the Edit menu. 
 
Loading previously saved data 

• To load data from a LAS file, first choose a log configuration that is compatible 
with that file. The Log ID’s that are selected in the log configuration must be 
present in the LAS file. Not all of the logs in the LAS file need to be loaded. 
DELogger will load only the data for each log chosen for display with the log 
configuration. 

• To load data, choose -Load from the File menu or click the associated toolbar 
button. Follow usual Windows 95 director and file selection procedures to locate 
the desired file. 

 
Entering information into the header 
Header information is retained in a permanent file. The saved data is always the last 
header used. Header information may be added, deleted, or edited. The header 
information shows a Description, an Entry, and an Abbreviation. The Description is the 
caption that is plotted in headers. The Entry is the header data. The Abbreviation is the 
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abbreviation used for LAS files. If you want your files to conform to the LAS standard so 
that they can be read by other applications, then use care in adding or deleting the 
Abbreviation. 

 
Operating the caliper arms 

• On the menu, select Hardware/Open and Close Caliper arms.  
• Click Open to open the arms and Close to close the arms. 
• Wait until the status box indicates that the arms are opened or closed. 

 
Printing to your printer 
The existing log may be printed to your windows printer by selecting Page Setup and Print 
from the File menu. When printed, the header is printed at the top of the log, then the log 
is printed as it is shown on your screen. One complete page is printed on your printer 
even if not all of the data are displayed on your screen. 
 
Saving currently displayed data 

• Data are saved and retrieved by DELogger in a file that is formatted according to 
the LAS version 2.0 format specified by the Canadian Well Logging Society. This 
file contains the log header data, other information, and the logging data. 

• Data may be saved at any time during or after logging. It is not required that files 
carry any particular file-type-extension but it is recommended that the LAS 
extension be used. 

• Data that has been previously saved in a LAS file may be loaded from that file 
back into DELogger. Additional data may then be collected. Then when the data 
are saved, all of the data will be saved. This provides a convenient way to make 
a complete log of a log, which was previously partially collected. When, during 
logging, data are collected at depths for which data is already present, the old 
data is overwritten. If the probe is run up and down the hole, then new data will 
overwrite old data. 
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Section 4: System Maintenance 
Maintenance on the 3A-300 winch consists of keeping it clean and dry. The 3A-300 Winch 
was designed to be weather/water resistant, however to insure a long, trouble free 
operating life, you should make every effort to keep it clean, dry, and protected from the 
elements. The use of a high-pressure spray - such as found in a car wash - is NOT 
recommended. Use moist cloths to wipe the unit down and remove contaminates. Use of 
a cable wiper (as found on Delta Epsilon tripods) will help remove most of the drilling mud 
and water before it reaches the winch and its case. 

Re-heading Instructions for GOI-4 Cablehead 
 

The following tools and hardware will be necessary to re-head the cable: 
• GOI-4/1-H-100 re-heading kit (see below). 
• Heavy duty cable cutter for 0.10” steel armor logging cable. 
• 1/8” hex wrench. 
• 4” Clamp or medium sized locking pliers. 
• Electrical wire cutters. 
• Electrical wire strippers. 
• Soldering iron (35W-75W) and rosin core solder. 
• Ohmmeter capable of measuring >100MΩ as well as zero to 100Ω. 
• Medium sized vise with smooth jaws (two pieces of soft wood may be used to 

protect the cable). 
• Waterproof (marine) grease. 

 
The following items are included in the re-heading kit available from Geotech. 

• 4” (10cm) of #24AWG Black wire. 
• 4” (10cm) of #24AWG Orange wire. 
• One ¼-28 Grease fitting. 
• One ¼-28x¼” SS Set screw. 
• One strain relief cone (#GOI-0x100-CONE). 
• One strain relief sleeve (#GOI-0x100-SLEEVE). 
• One connector Insert boot (#GOI-4-BOOT). 
• Four 2-014 O-rings (two for the cablehead plus two spares). 
• Two 2-013 O-rings (one for the CONNECTOR INSERT plus one spare). 
• One roll Scotch 88 electrical tape. 
• One tube O-ring grease (Suberlube). 
• 6" x Ø.75 adhesive lined heat shrink tubing. 
• 6" x Ø1.0 adhesive lined heat shrink tubing. 
• 4" x Ø1.5 adhesive lined heat shrink tubing. 
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Figure 4-1 
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Dismantling the Cablehead 
1. During the re-heading process, you will want to remove any kinked or damaged 

sections of cable. Unspool all cable with INSULATING SLEEVING and any that 
is damaged or badly kinked. Unspool an additional seven meters (20’) or so to 
give you room to work. Remove any electrical tape from the cablehead 
assembly. Slide the INSULATING SLEEVING away from the cablehead (towards 
the winch) past any kinked or damaged sections of cable. Leave at least two 
meters (6’) of good bare cable exposed. 
 

2. The inside of the cablehead is full of grease so do this step over paper or cloth 
rags that can be thrown away. Unscrew the BARREL and slide the CLAMP back 
up the LOGGING CABLE to expose the SLEEVE, CONE, WASHER, SPACER, 
BOOT, and INSERT. Then push on the INSERT (use a blunt object on the end 
opposite the wires) and force it out of the BARREL. Cut the LOGGING CABLE 
about two cm (1”) from the end of the BOOT. Remove and clean the grease off 
these parts, taking care not to damage any of the remaining wires. 

 
3. Dismantle the CONE and SLEEVE strain relief. It may be necessary to support 

the SLEEVE (from the cablehead end) and drive the CONE out of the SLEEVE.  
 

4. Cut off any damaged sections of cable. Inspect the INSULATING SLEEVING and 
replace it if necessary. To run electrical measurements, such as Resistivity or 
Spontaneous Potential, you need a minimum of 7.5 meters (25’) of INSULATING 
SLEEVING. Make sure to cut the cable cleanly and squarely. A sharp chisel can 
be used if a cable cutter is not available. Leave at least 2 meters (6’) of bare 
cable (extending past the end of the INSULATING SLEEVING) with which to 
work. 

Heading the Cable 
1. Make sure the following parts are on the cable in the order given, starting from 

the winch end of the cable: 
a) Minimum of 7.5 M (25’) of INSULATING SLEEVING. 
b) CLAMP with internal threads towards probe 
c) SLEEVE with small diameter opening tow  

 
 
 
 
 
 
 
 
 
 

 
2. Slide the INSULATING SLEEVING, CLAMP, and SLEEVE up the cable (out of 

the way) a couple of meters (6’). Tightly wrap several (6-8) wraps of electrical 
tape around the cable about 20cm (8”) down from the cut end of the cable. The 
tape helps keep the cable from slipping during re-heading. 

 

Figure 4-2 



 

18 
 

 
3. Very gently clamp the cable in a vise. Position 

the top of the tape even with the top of the vise. 
The cable is easy to damage so use as little 
pressure as possible. 
 

4. Slip the CONE onto cable, small end first, down 
onto the cable. 
 

5. Carefully unwrap each strand of the outer layer 
of armor. Straighten the 3-4cm (1.5-2”) nearest 
the top of the CONE and fold the strands down 
over the CONE. This helps when feeding the 
strands between the CONE and SLEEVE. 

 
 

 
6. Now, do the same with each strand in the inner layer, feeding the strands 

between the strands of the outer layer. Take care not to nick or kink the cable 
wire. 
 

7. Take the cable out of the vise and fold the strands down over the CONE. While 
holding the ends of the strands, slip the SLEEVE up over the strands and as far 
over the CONE as possible. The strands thus become clamped between the 
CONE and SLEEVE. Keep the strands straight, making sure no strands cross 
over one another. 
 

8. Clamp the cable very loosely at the bottom of the 
SLEEVE (cable wire pointing up). Allow the strands 
to extend through the vise. Grip all the strands and 
the cable and pull down firmly, seating the CONE 
into the SLEEVE. 
 

9. Pull evenly on each strand to work the CONE down 
into the SLEEVE. Make sure there are no loops on 
the top of the CONE as they can dig into the cable 
wire and short it to armor when the head is fully 
assembled. Pull on each strand individually, 
working around the CONE until 3mm (0.1”), or less, 
of the CONE remains outside the SLEEVE. It is 
very important the strands not cross over one 
another and no loops remain above the CONE. 
 

Figure 4-3 

Figure 4-4 

Figure 4-5 
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10. Remove the cable from the vise and trim the strands as close as possible to the 
bottom end of the SLEEVE (end nearest the winch). Remove the electrical tape. 

Making the Electrical Connections 
1. Slide the BOOT off the CONNECTOR INSERT and clean any grease from the 

electrical contacts. Unsolder and discard the old piece of cable wire. If the jumper 
wire (connecting INSERT pin 3 to 4) or the wire between INSERT pin 2 and the 
WASHER are nicked or otherwise damaged they must be replaced. Inspect the 
BOOT and replace it if it is nicked, cracked, or cut. Apply a small amount of 
grease onto the wires to help them slide through the BOOT. Take care not to 
cross any wires between the INSERT pins and their matching holes in the BOOT. 
 

2. Inspect the wire going from the WASHER to pin two (2) of the 
INSERT. Replace the wire if it is abraded or cut. Repair the 
connection if it is bad. Install the WASHER over the CABLE 
center conductor. Make sure the wire exits on the side that 
faces the probe. 
 

3. Cut the new CABLE center conductor, leaving 10cm (4”) free. 
Feed it through the BOOT, strip about 0.6cm (.25”) of insulation from the free 
end, and solder it into pin 1 of the INSERT. 
 

4. Inspect the jumper wire going from INSERT pin 3 to pin 4. Replace the wire if it is 
abraded or cut. Repair its connections if they are bad. 
 

5. Apply a small amount of grease to the inside of the BOOT and, while keeping 
moderate tension on the wires to the wires, slide the BOOT onto the INSERT 
until it snaps into place. Keep the wires straight. A kinked wire could cause a bad 
seal. Proper sealing depends on there not being any voids inside the boot. 
 

6. Install a new O-ring on the CONNECTOR INSERT (#013) and apply a small 
amount of grease to the O-ring and inside the threaded end of the BARREL. Slip 
the SPACER over the wires and use it to push the BOOT/INSERT assembly into 
the BARREL until the mating end is flush with the end of the BARREL. Align 
INSERT pin 1 (the one the CABLE connects to) with the key on the BARREL. 
Also, make sure no wires become pinched between the BARREL, SPACER, or 
BOOT/INSERT. 
 

7. Slide the CLAMP up over the CONE and SLEEVE, SPACER, BOOT and 
INSERT assembly. Turn the BARREL counter-clockwise two turns to pre-twist 
the wires. Then screw the BARREL assembly clockwise into the CLAMP. Make 
sure no wires become pinched between the SPACER, WASHER, BARREL, or 
CLAMP. Tighten the BARREL by hand and then use the pliers to snug it up (up 
to additional ¼ turn). Confirm that pin 1 of the INSERT is still aligned with the key 
on the BARREL. 

 
NOTE: Check the CLAMP periodically (once per month) to make sure it 
has not come loose. The cable should be reheaded at least every six 
months. More often if you are logging in corrosive borehole fluids. 
 

8. Disconnect the Winch to EPCI Depth/Speed display cable from the winch and 
perform the following tests: 
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a. Measure >100MΩ between the INSERT pin one (1) (or pin G of the 
plug) and cable armor.  
 

NOTE: If your ohmmeter does not have a 100MΩ range but has a 
conductance (1/ohms) range, a reading of less than 10nS is OK. 

 
 

b. Measure approximately 25Ω per 300m (1000’) of cable, between the 
INSERT pin 1 and pin G of connector J3. 
 

NOTE: If the cable does not pass both of these tests, you must cut the 
cable and start over! 
 
 

Injecting Grease and Reassembly 
1. Slide the INSULATING SLEEVING up against the CLAMP.  

 
2. Remove the SETSCREW and replace it with a GREASE FITTING. Use a grease 

gun filled with waterproof grease (such as marine trailer grease) to fill the cavity 
inside the CLAMP and BARREL. Grease will exit the small hole in the BARREL 
when it is full. Inject a bit more grease to make sure the entire cavity is full of 
grease. The grease will protect the connections and strain relief parts. Replace 
the GREASE FITTING with the stainless steel ¼-28 SS SETSCREW. Tighten 
only until snug. Do not over tighten the SETSCREW. 
 

3. Wipe excess grease from the end of the CLAMP. Use a “half-wrap” method 
(current wrap overlaps ½ of the previous wrap) to cover the CLAMP and at least 
5cm (2”) of INSULATING SLEEVING with high quality (Scotch 88) electrical tape. 
Apply two, or more, layers. 
 

4. Re-check the resistance measurements between the cable center conductor and 
cable armor (described in the previous section). If all tests pass, replace the O-
rings (two each 2-114) on the cablehead. Apply a small amount of O-ring grease 
to the O-rings and carefully slip them into their glands. Take care not to stretch 
the O-rings as you are installing them. 
 

5. Reconnect the Winch to EPCI Depth/Speed display cable and test the system. 
Open the DELogger program on your PC and click on “Hardware/Check 
hardware” to see that the program can communicate with the attached probe. 
The probes model and serial numbers will be displayed. 
 

6. Put the PROTECTOR CAPS back on the cablehead and probe when you are 
finished. 

 

 

 

Figure 4-6: Typical finished assembly 
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Section 5: System Troubleshooting 
 
Problem: You are getting frequent messages “Serial Communications Error” while 
logging.  
 
Solution: It is possible that your computer is busy working on other tasks besides 
DELogger. Check your Startup group (see Windows Help) and remove any programs that 
are being automatically started when you boot up. 
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Section 6: Parts and Accessories 
 

Qty Part Number Description 
Kit 52251016 GOI-4/1-H-100 REHEADING KIT 
4” PPE001025010 WIRE, 24AWG, BLACK, .010 PVC 
4” 17500241 WIRE, 24AWG, ORANGE, STR, .010” PVC 
1 12251304 ADAPTER, ZERK, SS3, ¼”-28 MALE 
1 12251305 SET SCREW, SS8, ¼-28 x ¼” 
1 22251084 GOI-4 CABLEHEAD STRAIN RELIEF CONE 
1 22251082 GOI-4 CABLEHEAD STRAIN RELIEF SLEEVE 
1 12251084 BOOT, BLK, 4PIN 
4 12251891 O-RING, BUNA, -014 
2 12251890 O-RING, BUNA, -013 
1 12251084 TAPE, SCOTCH 88 ELECTRICAL, 66’ 
1 12251303 GREASE, SILICONE, 3OZ 
6” 12251171 HEATSHRINK TUBING ¾” 
6” 12251065 HEATSHRINK TUBING 1” 
4” 12251244 HEATSHRINK TUBING 1 ½” 
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Appendix A 
When using a probe with electric logs (resistivities, spontaneous potential, etc.) all 
exposed cablehead/probe top surfaces must be insulated from the borehole fluid by 
wrapping them with high quality electrical tape. 
 

Also keep any exposed probe housing around the electrodes insulated, but do not cover 
any of the electrodes with electrical tape. Apply tape from the edge of the insulating 
washer to the neoprene sleeving. Cover at least 1” (2-3cm) of the neoprene sleeving. 
Overlap each wrap by at least half with the next new wrap. 

Charging Batteries in Battery Powered Probes 
The GE9409 Gamma Electric probe (GN9506 with a Long Normal adapter installed) is the 
only Delta Epsilon probe with internal batteries. The batteries will supply up to 100 hours 
of operation and will normally recharge in three hours. To charge the probe batteries, 
connect the AC Adapter to the Probe Battery Charge Adapter. The battery charge adapter 
is then plugged into the probe. Plug the AC Adapter into a power source 100VAC - 
240VAC 0.7A @ 50/60Hz. Charging will take approximately three hours. The batteries are 
protected from overcharge and can be left on charge indefinitely with no damage.  

 
 
NOTE: To prevent degradation or damage, the GE9409’s batteries should 
be charged at least once every six months. 
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Appendix B 

Setting Up Your USB Port 
Note, the winch must be turned ON and its USB cable plugged into your PC before 
launching DELogger. This is to allow Windows to recognize the USB connection, open 
and assign a COM port to it. In addition the Serial Port in DELogger must be set to match 
the COM port Windows assigned to your logger. Open Devices and Printers (as shown 
below) and double-click on the FT232R USB UART icon. 

 
 
 

 
This will open the FT232R USB UART 
properties window. Click on the 
Hardware tab to see which port 
Windows has assigned to your logger 
(COM port 2 in this example). 
 
 
 
DELogger's Serial Port 
number must be set to match 
the Windows COM port. In 
DELogger select Edit/Log 
Configuration and then the 
Logging Parameters tab. Use 
the up/down arrows to set the 
matching COM port number 
and click OK. 
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Revision History 

Project # Description Date 
2225 Created Manual – AH & GR 12/4/2023 
2578 Revision to System Operation Instructions – AH 04/29/2026 
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NOTES 
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The Warranty 
 
For a period of one (1) year from date of first sale, product is warranted to be free from 
defects in materials and workmanship. Geotech agrees to repair or replace, at Geotech’s 
option, the portion proving defective, or at our option to refund the purchase price thereof. 
Geotech will have no warranty obligation if the product is subjected to abnormal operating 
conditions, accident, abuse, misuse, unauthorized modification, alteration, repair, or 
replacement of wear parts. User assumes all other risk, if any, including the risk of injury, 
loss, or damage, direct or consequential, arising out of the use, misuse, or inability to use 
this product. User agrees to use, maintain and install product in accordance with 
recommendations and instructions. User is responsible for transportation charges 
connected to the repair or replacement of product under this warranty. 
 

Equipment Return Policy 
 
A Return Material Authorization number (RMA #) is required prior to return of any 
equipment to our facilities, please call our 800 number for appropriate location. An RMA # 
will be issued upon receipt of your request to return equipment, which should include 
reasons for the return. Your return shipment to us must have this RMA # clearly marked 
on the outside of the package. Proof of date of purchase is required for processing of all 
warranty requests. 
 
This policy applies to both equipment sales and repair orders. 
 

FOR A RETURN MATERIAL AUTHORIZATION, PLEASE CALL OUR 
SERVICE DEPARTMENT AT 1-800-833-7958. 

 
Model Number:   ________________ 
 
Serial Number:   ________________ 
 
Date of Purchase: ________________ 
 
 

Equipment Decontamination 
 
Prior to return, all equipment must be thoroughly cleaned and decontaminated. Please 
make note on RMA form, the use of equipment, contaminants equipment was exposed to, 
and decontamination solutions/methods used. Geotech reserves the right to refuse any 
equipment not properly decontaminated. Geotech may also choose to decontaminate the 
equipment for a fee, which will be applied to the repair order invoice. 
 
 
 



 

 
Geotech Environmental Equipment, Inc. 

2650 East 40th Avenue Denver, Colorado 80205 
(303) 320-4764 ● (800) 833-7958 ● FAX (303) 322-7242 

email: sales@geotechenv.com website: www.geotechenv.com 
 

 

 
 
 
 

http://www.geotechenv.com/
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